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GLOSARIO 1,2 

 
 
ArcGis: Software en el campo de los Sistemas de Información Geográfica o SIG, 
compuesto por varias aplicaciones para la captura, edición, análisis, tratamiento, 
diseño, publicación e impresión de información geográfica. (Producido y 
comercializado por ESRI) 
 
ArcMap: Es el componente principal de ArcGIS (ESRI), permite al usuario explorar 
los datos dentro de un conjunto de datos, simbolizan características en 
consecuencia, y crear mapas. 
 
ArcToolbox: Conjunto de herramientas de ArcGIS (ESRI), que se emplea para el 
geoprocesamiento: combinar capas de información, manipulación de los datos, 
definición y transformación de sistemas de coordenadas, y otros. 
 
Balance Hídrico: Es el equilibrio entre todos los recursos hídricos que ingresan al 
sistema y los que salen del mismo, en un intervalo de tiempo determinado 
 
Calentamiento Global: Fenómeno de aumento paulatino de las temperaturas 
experimentado durante el último siglo en la Tierra. 
 
Caudal: se denomina al volumen de agua que circula por el cauce de un río en un 
lugar y tiempo determinados. 
 
Cuenca Hidrografica: Es el área de aguas superficiales o subterráneas que vierten 
a una red hidrográfica natural con uno o varios cauces naturales, de caudal continuo 
o intermitente, que confluyen en un curso mayor que, a su vez, puede desembocar 
en un río principal, en un depósito natural de aguas, en un pantano o bien 
directamente en el mar. 
 
DEM: (Modelo Digital de Elevación) Es una representación visual y matemática de 
los valores de altura con respecto al nivel medio del mar, que permite caracterizar 
las formas del relieve y los elementos u objetos presentes en el mismo, estos valores 
están contenidos en un archivo de tipo raster con estructura regular, el cual se 
genera utilizando equipo de cómputo y software especializados. 
 
 
 
1ESRI 2014. ArcGIS Desktop: Release 10.2.2 Redlands, CA: Environmental Systems Research Institute. 
Disponible en Internet: http://support.esri.com/other-resources/gis-dictionary/browse/r 
 
2Definicion ABC, Medio Ambienta, Copyright © 2007-2016   Disponible en Internet: 
http://www.definicionabc.com/category/medio-ambiente/ 

https://es.wikipedia.org/wiki/R%C3%ADo
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Ecosistemas Estratégicos: Son aquellas áreas dentro del territorio que gracias a 
su composición biológica, características físicas, estructuras y procesos ecológicos, 
proveen bienes y servicios ambientales imprescindibles e insustituibles para el 
desarrollo sostenible y armónico de la sociedad.  
 
Fill: Herramienta que se utiliza para rellenar las imperfecciones existentes en la 
superficie Del modelo digital de elevaciones (MDE), de Tal forma que las celdas en 
depresión alcancen el nivel del terreno de alrededor, con el objetivo de poder 
determinar de forma adecuada la dirección del flujo 
 
Interpolación: Se denomina como  la obtención de nuevos puntos partiendo del 
conocimiento de un conjunto discreto de puntos. 
 
Oferta Hídrica: Es el estudio del recurso hídrico para satisfacer la demanda de la 
población y de los ecosistemas. 
 
Pixel: Es la unidad más pequeña y diminuta de una imagen digital, y está presente 
en un inmensurable número para formar una imagen completa. 
 
Raster: Es una matriz de celdas (o píxeles) organizadas en filas y columnas 
(cuadrícula) en la que cada celda contiene un valor que representa una información 
 
Shapefile: Es un formato de almacenamiento de datos vectoriales de Esri para 
almacenar la ubicación, la forma y los atributos de las entidades geográficas. Se 
almacena como un conjunto de archivos relacionados y contiene una clase de 
entidad. 
 
Software: Es el conjunto de los programas de cómputo, procedimientos, reglas, 
documentación y datos asociados, que forman parte de las operaciones de un 
sistema de computación. 
 
Spatial Analyst: (analisis espacial) Una extensión ArcGIS que proporciona el 
modelado espacial y características de análisis.  
 
Watershed: Herramienta que permite la delineación de las cuencas mediante un 
punto de desembocadura. 
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RESUMEN 
 

La problemática del calentamiento global se describe como la teoría que predice el 
aumento futuro de las temperaturas del planeta durante las próximas décadas. El 
aumento de  la población urbana en el municipio de Ortega ha generado una alza 
en la demanda del recurso hídrico, aparte de la problemática que se viene 
presentado en las zonas rurales como es la expansión de la frontera agrícola, ha 
creado una preocupación referente con la sostenibilidad hídrica de la zona; teniendo 
en cuenta que el municipio, ni las entidades ambientales poseen datos para la 
implantación de políticas que ayuden a adquirir, recuperar y conservar las fuentes 
hídricas y sus ecosistemas estratégicos, el objetivo de este trabajo fue determinar 
las áreas estratégicas para el abastecimiento hídrico de la zona urbana del 
municipio de Ortega-Tolima a través de Arcgis 10.2.2. Se diagnosticó que la cuenca 
del Rio Anaba la cual abastece el acueducto la zona urbana de Ortega, cuenta con 
4.000 hectáreas aproximadamente posee una precipitación media baja dentro de la 
subzona hidrográfica, registra una temperatura media de 26 C° y una 
Evapotranspiración Alta, así mimos se identificaron 98 corrientes de primer orden; 
las cuales son de un grado de mayor de importancia para la conformación del cauce 
principal. Se concluye que es una cuenca susceptibles a los cambios generados por 
el Cambio Climático, lo cual, podría genera una preocupación por la reducción de 
su caudal medio (oferta Hídrica) en los próximos años si continua el proceso de 
calentamiento del planeta; además, el incremento acelerado de la frontera agrícola 
y de su población en el sitio, acrecentad un panorama desalentador para la cuenca 
abastecedora del municipio, por lo tanto estudio de esta clase permite generar 
información que ayudan en la gestión y planificación de las políticas de inversión 
(1% del presupuesto), para la adquisición y mantenimiento de ecosistemas 
estratégicos y/o crear un esquemas de financiamiento de pago por servicios 
ambientales. 
 
 
 
PALABRAS CLAVES: Ecosistemas Estratégico, Cuenca Del Rio Anaba, Subzona 
Hidrográfica, Herramientas Geoinformaticas, Recurso Hídrico. 
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ABSTRACT 
 

The problem of global warming is described as the theory predicts the future 
increase in global temperatures over the coming decades. The increase in urban 
population in the municipality of Ortega has generated increased demand of water 
resources, apart from the problem that has been presented in the rural areas such 
as the expansion of the agricultural frontier, has created a concern regarding the 
water sustainability in the area; considering that the municipality or environmental 
entities have data to implement policies that help acquire, restore and preserve water 
sources and its strategic ecosystems, The objective of this work was to determine 
the strategic areas for water supply in the urban area of the municipality of Ortega- 
Tolima through 10.2.2 Arcgis. Diagnosed as the River Basin Anaba aqueduct which 
supplies the urban area Ortega, has approximately 4,000 hectares has low rainfall 
within the river subzone, has an average temperature of 26C°, and 
Evapotranspiration Alta, mimes and 98 first order streams were identified; which they 
are of a higher degree of importance to the shaping of the main channel. It is 
concluded that a watershed susceptible to changes caused by climate change, 
which could generate a concern for reducing its average flow (supply of water 
resources) in the coming years if it continues the process of global warming; also 
accelerated the agricultural frontier and its people on the site, increase generates a 
grim outlook for the upstream basin of the municipality, therefore study of this kind 
can generate information that help in the management and planning of investment 
policies (1% of the budget), for the acquisition and maintenance of strategic 
ecosystems and / or create a financing schemes of payment for environmental 
services. 
 
 
 
KEY WORDS: Strategic Ecosystems, Anaba River Basin, Hydrographic Subzone, 
Geoinformatics Tools, Hidric Resource. 
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INTRODUCCIÓN 
 

La problemática del calentamiento global se describe como la teoría que predice el 
aumento futuro de las temperaturas del planeta durante las próximas décadas a 
partir del incremento en el valor medio de la temperatura observado en la atmósfera 
terrestre y en los océanos del planeta. La década de los noventa, fue la más caliente 
en los últimos mil años, el clima del planeta siempre ha variado, el problema del 
cambio climático es que el ritmo de estas variaciones se ha acelerado durante las 
últimas décadas, de manera anómala. El calentamiento global ha surgido desde la 
Revolución Industrial, se puede observar también a principios del Siglo XX, y 
finalmente en los últimos 50 años.  
 
En los últimos 8000 años, alrededor de la mitad de la cubierta forestal del mundo 
habría sido destruida, en la década de 1990 Brasil fue el país con el mayor número 
de área deforestas con un total de 22.264 km², cinco de los 10 países que más 
deforestan en el mundo son de África. En Colombia se deforestan cerca de 8 km² 
anuales debido a no existe una conciencia pública sobre el control del tráfico ilegal 
de la madera. 
 
La problemática de deforestación ha llevado a que los cauces sufran una sequía en 
la época de sequía, debido a que la pérdida del bosque riparios genera la reducción  
de los manantiales que surten del recuro hídrico a las cuencas de los ríos. Así mismo 
el aumento de las temperaturas ha generado en los valles de los ríos una escases 
de agua, teniendo encuentra que los veranos son cada vez más largos lo que 
provoca no solo la escases del recurso hídrico si no el aumento de los  incendios 
forestales induciendo un agravante de las circunstancias. 
 
En Sudamérica, el calentamiento parece tener menor intensidad sobre el Cono Sur 
(1º a 2ºC), en Colombia se calentarían menos las zona de relieve montañoso como 
la Región Andina(2º a 3ºC), y más las planicies y praderas de las regiones planas 
(Duque, 2010). 
 
El Instituto de Hidrología, Meteorología y Estudios Ambientales – IDEAM, mediante 
una evaluación de los modelos climáticos globales que mejor representan el clima 
regional y con la ayuda de modelos climáticos regionales de alta resolución espacial,  
simulo diversos escenarios climáticos que ocurrirían sobre el territorio colombiano 
en los decenios venideros del siglo XXI. Con base en lo anterior se plantea como el 
escenario de cambio climático más probable para el país el siguiente: 
 
La temperatura media en el territorio nacional continuará incrementándose durante 
el transcurrir del siglo XXI de tal manera que para el período 2011-2040 habría 
aumentado en 1.4±0.4°C, para 2041- 2070 en 2.4±0.5°C y para 2071-2100 en 
3.2±0.7°C. Los aumentos más significativos de la temperatura media se esperarían 
en gran parte de las regiones Caribe y Andina especialmente en los departamentos 
de Sucre, Norte de Santander, Risaralda, Huila y Tolima. 
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Si la temperatura en Colombia se incrementa en 3ºC, los pisos térmicos se 
modifican: esto equivale a modificar el clima de cada región y ciudad por otro más 
cálido, equivalente a 500 m más cerca al nivel del mar. En Colombia estarían 
amenazados ecosistemas como páramos, manglares, ambientes coralinos, 
glaciares y todas las selvas andinas, costeras y de la Amazonía. En 25 años, entre 
1983 y 2008, la extensión de los glaciares de Colombia se ha Reducido a la mitad 
(Pabón, 2007). 
 
El ministerio de Ambiente y Desarrollo Sostenible nos muestra un panorama 
alarmante con respecto a la problemática ambiental del país, una tasa de 
deforestación en Colombia 310.349 hectáreas por año, en el periodo comprendido 
de 1990 a 2010. La ampliación de la frontera agropecuaria paso del 5% al 10%anual, 
la disponibilidad hídrica disminuye en1.000m³ por persona al año (IDEAM, 2010), 
generando una degradación de las cuencas, creando unos costos altísimos para la 
sociedad. 
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1. ÁREA PROBLEMÁTICA 
 

El Municipio de Ortega está situado al sur del Departamento del Tolima, República 
de Colombia, localizado a dos horas de la ciudad de Ibagué, capital del 
departamental recostado a las estribaciones orientales de la Cordillera Central e 
incluido en la Subcuenca del Río Magdalena. Sus 943,51 kilómetros cuadrados 
están enclavados en el Gran Valle del Alto Magdalena; posee aproximadamente 0.6 
kilómetros cuadrados en área urbana y 942,91 kilómetros cuadrados en zona rural. 
Su privilegiada posición altitudinal le permite tener: 708 kilómetros cuadrados en 
zona cálida, 182 kilómetros cuadrados en zona media y 53.51 kilómetros cuadrados 
en zona fría.  
 
 

 
Figura No. 1: Localización del Municipio de Ortega, Tolima. 
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Su cabecera municipal se encuentra a 402 metros de altura sobre el nivel del mar, 
con una temperatura promedia de 26 grados centígrados, presentándose valores 
máximos de 35 grados centígrados y valores mínimos de 23 grados centígrados. En 
esta zona, los meses de mayor calor son enero, febrero, junio, julio, agosto y 
diciembre 
 
La población de Ortega, entre 1951 y 1995 ha aumentado de 21.660 a 36.516 
habitantes. De estos 36.516 habitantes, 31.500 habitan en el sector rural y 5.016 
habitan en el sector urbano, (PBOT de Ortega, 2001). 
 
Este incremento de la población urbana ha generado una alza en la demanda del 
recurso hídrico, aparte de la problemática que se viene presentado en las zonas 
rurales como es la expansión de la frontera agrícola, ha creado una preocupación 
referente con la sostenibilidad hídrica de la zona; teniendo en cuenta que el 
municipio, ni las entidades ambientales poseen datos para la implantación de 
políticas que ayuden a adquirir, recuperar y conservar las fuentes hídricas y sus 
ecosistemas estratégicos, además por su localización el municipio de Ortega-
Tolima, se cataloga en riesgo Alto por la afectación del cambio climático. Teniendo 
en cuenta lo anterior surge la necesidad de desarrollar este estudio con el fin de 
generar información que ayude a la toma de decisiones en cuanto a la preservación 
de las áreas de importancia estratégica de recarga hídrica que abastecen o proveen 
del preciado líquido a  la zona urbana del municipio. 
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2. OBJETIVOS 
 

2.1 OBJETIVO GENERAL 
 
Determinar las áreas estratégicas para el abastecimiento hídrico de la zona urbana 
del municipio de Ortega en el departamento del Tolima, a través Arcgis 10.2.2. 
 
 
2.2 OBJETIVOS ESPECÍFICOS 
 
 

 Identificar la Zona hidrográfica a la cual pertenece el área de estudio. 
 

 Determinar las estaciones meteorológicas con influencia dentro de la zona 
de estudio a través del método de Los Polígonos de Thiessen. 
 

 Tabular la información de las estaciones Meteorológicas del IDEAM, con el 
fin de hallar los parámetros climáticos (precipitación, temperatura, 
evapotranspiración), de la Subzona Hidrográfica y así obtener la oferta 
hídrica del área de estudio.    
 

 Generar información cartográfica de Precipitación, Temperatura, 
Evapotranspiración y Oferta hídrica del área de estudio, asimismo de la 
delimitación de la cuenca hidrográfica y de sus áreas de importancia 
estratégica de la cual se abastece la zona urbana del municipio de Ortega 
Tolima. 
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3. JUSTIFICACIÓN 
 

La creciente demanda del recurso hídrico por parte de los habitantes del municipio 
de ortega viene generando conflictos asociados a su acceso, debido a que cualquier 
proceso de desarrollo económico necesita como materia principal el agua; además, 
el deterioro del recurso debido a la creciente contaminación, ampliación de la 
frontera agrícola y a la deforestación de zonas estratégicas de recarga hídrica, 
agrava el panorama de acceso a este  líquido vital para la supervivencia humana. 
 
La gestión del recurso hídrico tiene un papel fundamental el conocimiento de la base 
técnica del agua. El conocimiento base de los recursos hídricos permite identificar 
los intereses y aspiraciones de los diversos actores que hacen uso del agua en las 
cuenca hidrográficas y permite inferir o formular proyectos de mitigación o 
adaptación frente al deterioro acelerado del agua. 
 
Este estudio se realiza teniendo en cuenta la necesidad de contar con información 
por parte del municipio de Ortega, a fin de precisar las áreas de mayores importancia 
estratégica para el abastecimiento de su zona urbana, lo que permitirá adelantar las 
acciones de planificación territorial de dichas áreas; asimismo se podrá emplear 
como base para la toma de decisiones por parte de entidades territoriales y de esta 
forma dar cumplimiento a la Política Nacional de Gestión Integral del Recurso 
Hídrico. 
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4. MARCO TEÓRICO 
 

La expresión “Áreas de Importancia Estratégica” (AIE) para el recurso hídrico fue 
adoptada a través de la Ley 99 de 1993, artículo 111, posteriormente modificado 
por la Ley 1450 de 2011, para señalar aquellas áreas que deben mantenerse con el 
propósito de conservar la disponibilidad de las fuentes de agua para acueductos. 
También estableció la norma que las autoridades ambientales “definirán las áreas 
prioritarias a ser adquiridas con estos recursos o dónde se deben implementar los 
esquemas por pagos de servicios ambientales de acuerdo con la reglamentación 
que el Ministerio de Ambiente, Vivienda y Desarrollo Territorial expida para el 
efecto”. En cumplimiento de esta disposición el Ministerio de Ambiente promulgó el 
Decreto 953 de 2013, en el que se ratifica para las autoridades ambientales la labor 
de identificar, delimitar y priorizar las áreas de importancia estratégica, que deberán 
ser adquiridas por parte de las entidades territoriales, (CVC, 2014). 
 
La identificación de áreas estratégicas para la conservación del recurso hídrico a 
partir de SIG, es la herramienta que tanto los entes territoriales como las 
Autoridades Ambientales requieren para la realizar una adecuada inversión en la 
adquisición de predios para dicho fin, y así dar cumplimiento a la Política Nacional 
de Gestión Integral del Recurso Hídrico, al Artículo 11 de la Ley 99 del 1993, al 
Artículo 210 de la Ley 1450 y al Decreto 953 del 2013 (Muñoz, 2015). 
 
La Cuenca Hidrográfica es reconocida internacionalmente como el territorio idóneo 
para gestionar el agua y los recursos naturales vinculados con ella; las cuencas 
forman sistemas y subsistemas interrelacionados, interdependientes e 
inseparables, por ello la gestión de una cuenca hidrográfica requiere de 
herramientas integrales de planeación, instrumentos de política y sistemas de 
participación social para el aprovechamiento correcto de los recursos naturales, 
(Jimenez, 2015). 
 
En las últimas décadas el recurso hídrico es uno de los componentes ambientales 
más afectados por la intervención antrópica, las actividades humanas y la 
naturaleza misma ejercen presión sobre los recursos naturales; entre los impactos  
más relevantes que afectan la sostenibilidad del recurso hídrico es el avance de la 
frontera agrícola, la cual genera perdida de cobertura vegetal, vital en el 
sostenimiento de los drenajes de primer orden, los cuales abastecen o conforman 
las redes hídricas principales de las cuencas hidrográficas. Además, Pabón (2007), 
señala que a lo largo del siglo XXI, los aumentos más significativos de temperatura 
media se ubicarán en los departamentos de Norte de Santander, Risaralda, Huila, 
Sucre y Tolima. Asimismo, las mayores reducciones de lluvia se esperarían en los 
departamentos del Huila, Putumayo, Nariño, Cauca, Tolima, Córdoba, Bolívar y 
Risaralda. Sin embargo, se evidencia en algunos casos que en los departamentos 
de Huila, Cauca, Nariño, Risaralda y Tolima ya se empezaron a evidenciar dichas 
problemáticas desde el año 2011. 
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Galindo et, al. (2006), menciona la importancia de delimitar e identificar las áreas de 
importancia estratégica que permita un manejo integral de la cuenca a través de un 
modelo de elevación (MDE), con el fin de generar información para la toma de 
decisiones que reduzcan los efectos del calentamiento global y el uso sostenible del 
recurso hídrico. 
 
En Colombia, es necesario contar con información actualizada y cada vez más 
precisa, sobre la distribución regional y local de sus disponibilidades de agua y la 
distribución territorial de sus usos, a fin de precisar y ordenar las áreas con mayores 
peligros de desabastecimiento y adelantar las acciones de planificación y regulación 
del uso del recurso hídrico (Vélez, et al. 2000). 
 
En cuanto al departamento del Tolima, es importante resaltar que el estado del arte 
del recurso hídrico superficial y subterráneo ha tenido pocos avances en relación a 
la conservación y sostenibilidad, generando un esfuerzo enorme en la realización 
de estudios que permitan la articulación de la situación actual del recurso hídrico 
con las demandas futuras de este, (CORTOLIMA, 2013). 
 
Teniendo en cuenta lo anterior, el presente estudio pretende generar herramientas 
de identificación base, de las áreas de importancia estratégica para la conservación 
de las zonas de abastecimiento hídrico del perímetro urbano del municipio de 
Ortega, el cual es cada vez más afectado ambientalmente por la presión de las 
actividades antrópicas y además de los factores del cambio climático. 
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5. METODOLOGÍA 
 

5.1 TIPO DE TRABAJO 
 
El presente trabajo es una investigación aplicada, que busca identificar el área de 
mayor importancia estratégica para el abastecimiento hídrico de la zona urbana del 
municipio de Ortega en el departamento del Tolima, por medio de Herramientas 
Geoinformaticas y análisis Hidrológicos.   
 
5.2 PROCEDIMIENTO 
 
5.2.1 Fase 1. Identificación de la Zona hidrográfica a la cual pertenece el área 
de estudio. 
 
De acuerdo con la metodología de zonificación y codificación de unidades 
hidrográficas e hidrogeológicas de Colombia, realizada por el Instituto de Hidrología, 
Meteorología y Estudios Ambientales “IDEAM”, el cual es un documento que 
constituye la base para la planificación de cuencas hidrográficas que se legitima en 
la Política Nacional para la Gestión Integrada de Recurso Hídrico difundida por el 
Ministerio de Ambiente y Desarrollo Sostenible en el 2010 (MADS, 2010); la zona 
de estudio o de interés pertenece a la Subzona Hidrográfica del rio Tetuán y rio 
Ortega, (el límite de dicha subzona se encuentra digitalizada en formato shapefile). 
 
5.2.2 Fase 2.  Determinación de las estaciones con influencia dentro de la zona 
de estudio a través del método de Los Polígonos de Thiessen.  
 
Los polígonos de Thiessen, son una construcción geométrica que permite construir 
una partición del plano euclídeo. Este es uno de los métodos de interpolación más 
simples, basados en la distancia euclidiana, especialmente apropiada cuando los 
datos son cualitativos. Dichos polígonos se crean al unir los puntos entre sí, 
trazando las mediatrices de los segmento de unión. Las intersecciones de estas 
mediatrices determinan una serie de polígonos en un espacio bidimensional 
alrededor de un conjunto de puntos de control, de manera que el perímetro de los 
polígonos generados sea equidistante a los puntos vecinos y designan su área de 
influencia3. 
 
El presente método requiere del conocimiento de la localización de cada una de las 
estaciones que se encuentren dentro o en la periferia de la cuenca para proceder a 
su aplicación, reconociendo el área de influencia de cada estación. Así se van 
estableciendo triángulos entre las estaciones más cercanas uniéndolas con 
segmentos rectos sin que éstos se corten entre sí y tratando que los triángulos sean 
lo más equiláteros posibles.  
 
 

3Fundación Wikimedia, Inc. (13 de marzo de 2016). Wikipedia. Disponible en Internet: 
https://es.wikipedia.org/wiki/Pol%C3%ADgonos_de_Thiessen Coporro. 
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Lo anterior fue posible gracias a un shapefile de puntos, de todas las estaciones 
Hidrometereologicas a nivel nacional, georreferenciada en MAGNA-SIRGAS, 
suministrada por el Instituto de Hidrología, Meteorología y Estudios Ambientales-
IDEAM.  
 
Posteriormente se dibujan líneas bisectoras perpendiculares a todos los lados de 
los triángulos, las que al unirse en un punto común dentro de cada triángulo 
conforma una serie de polígonos que demarcan el área de influencia de cada 
estación. El área de influencia de cada estación es nombrada como polígono, y está 
comprendida del área de influencia dentro de la zona de estudio (Subzona 
Hidrográfica del rio Tetuán y rio Ortega). 
 
Este procedimiento se llevó a cabo mediante el software Arcgis 10.2.2; software 
especializado en el campo de los Sistemas de Información Geográfica, Realizando 
la siguiente ruta: 
 
Arcmap Arctoolbox        Analysis Tools Proximity Create Thiessen 
Polygons 
  
 
5.2.3 Fase 3. Tabular la información del IDEAM, estaciones Meteorológicas que 
tienen influencia en la subzona hidrográfica a la cual pertenece el municipio 
de Ortega.  
 
Para el cálculo de precipitación, temperatura, evapotranspiración Potencial y Real y 
Balance Hídrico, se tomó como referencia la metodología aplicada por CORTOLIMA 
(2015) en el estudio Balance Hídrico de largo plazo en la Subzona Hidrográfica del 
Rio Saldaña, afluente de la gran cuenca del Magdalena. 
 
Esta metodología propone la selección de estaciones que tengan datos 
consistentes, recomendando tomar el periodo comprendido de 1992 al 2012, ya que 
en este periodo de tiempo se encuentran los datos más completos, además de tener 
menos del 1% de datos faltantes. Teniendo en cuenta esto, se procede a descartar 
las estaciones que no cumplan con las recomendaciones hechas anteriormente, 
asimismo aquellos datos que tengan más de un dato faltante por año.  
 
Por lo anterior, y basados en el método de los polígonos de Thiessen, se 
seleccionaron un total de 20 estaciones Meteorológicas que se encuentran dentro 
del área de influencia y que cumplieron con las exigencias anteriormente expuestas, 
(Fig. 2). 
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Figura No. 2: Selección de las estaciones dentro del área de influencia de la zona 

de estudio, tabla de atributos software Arcgis 10.2.2. 
 
 

 Precipitación  
 
Para el análisis de este parámetro se tomaron los datos de las precipitaciones 
medias mensuales multianuales de las 20 estaciones, que se localizan dentro del 
área de influencia, comprendidas dentro del periodo 1992 al 2012, (CORTOLIMA, 
2015). 
 
Para el cálculo de los datos faltantes, se aplicó el Método de Interpolación con 
Otras Estaciones propuesto por Paulhus y Kohler (1952), debido a la practicidad y 
similitudes topoclimáticas de la mayoría de las estaciones seleccionadas con datos 
faltantes, este método consiste en estimar el dato faltante, como el promedio de la 
precipitación ocurrida en tres estaciones adyacentes que están bajo la misma 
influencia topoclimática en el tiempo referente (dato faltante), siempre y cuando la 
precipitación anual de cada una de las tres estaciones adyacentes difiera 
descriptivamente, en menos del 10% de la precipitación anual de la estación con el 
dato faltante. 
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Dj=     aj + bj + cj 
 3 

 
Dj: Precipitación estimada para el día j     
aj + bj + cj: Precipitación registrada en las estaciones de referencia el día j 

 

Posteriormente se procede a la suma de las medias mensuales multianuales (Tabla 
No.1), el resultado total de cada estación se adjunta a la tabla de atributos del 
shpefile de estaciones dentro del área de estudio, a través de un Joins and Relates; 
seguido se interpolan las precipitaciones medias mensuales totales de cada 
estación por medio del método IDW, que se encuentra dentro de Arctoolbox, en la 
herramienta Spatial Analyst Tools, Interpolation, IDW, de ArcMap.  

 
Para la determinación de las precipitaciones media dentro del área de estudio, se 
realiza el metodo IDW “Inverse Distance Weighted” (ponderación por distancia), el 
cual combina el concepto de vecindad entre sitios con disponibilidad de datos con 
un cambio gradual de las superficies definidas con una tendencia. Se supone que 
el valor del atributo Z en una posición donde el valor del atributo no es conocido, es 
un promedio de los valores de sus vecinos pero donde los vecinos más cercanos 
tienen más peso o importancia que los  más alejados. (FAO, 2003); “creando un 
raster de precipitación” 

 
 

 Temperatura   
 

Para determinar la Temperatura dentro del área de estudio y su comportamiento, se 
tuvieron en cuenta los datos de las estaciones del IDEAM, seleccionadas dentro de 
la zona de influencia; sin embargo, no todas las estaciones cuentan con datos 
completos, por lo cual nos remitimos a las sugerencias del estudio metodología 
aplicada en el Balance Hídrico de largo plazo en la subzona hidrográfica del rio 
Saldaña, afluente de la gran cuenca del magdalena (CORTOLIMA, 2015); en donde 
el análisis del comportamiento temporal y espacial de las temperaturas se realizó a 
partir de la relación existente entre la altura y la temperatura; los autores 
recomiendan tomar la estación de anchique como referencia para el cálculo de 
datos de temperatura. Esta estación no se encuentra dentro del área de influencia 
de la zona de estudio, pero por su proximidad al área, y al tener el registro de datos 
completos puede aplicarse como testigo o referencia de temperatura, y así obtener 
resultados más confiables para las estaciones con datos faltantes.  
 
En cuanto al análisis del comportamiento de la temperatura, se determina la relación 
existente entre la temperatura y la altura sobre el nivel del mar, en donde la 
temperatura disminuye en la medida que aumenta la altura en una relación de 3.2 
°C por cada 500 metros de altura, esto se denomina como gradiente de temperatura 
(CORTOLIMA, 2015): Temperatura = diferencias de Altura, (Estación A – Estación 
B)  * (- 0.0064) 
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A partir de lo anterior, se multiplica el resultado obtenido a través del gradiente de 
temperatura con los registros de la estación base o de referencia para obtener los 
registros de las estaciones con datos faltantes.  
 
Seguidamente se calcula el promedio de las medias mensuales multianuales para 
las 20 estaciones con influencia dentro del área de estudio (Fig. 2), posteriormente  
se adjunta a la tabla de atributos mediante Joins and Relates al shapefile estaciones 
dentro del área de estudio, y seguidamente se interpolan los promedios de 
temperatura totales a través del método IDW, que se encuentra dentro de 
Arctoolbox, en la herramienta Spatial Analyst Tools, Interpolation, IDW, software 
Arcgis 10.3, para obtener un capa raster que nos represente espacialmente la 
distribución de temperaturas dentro de la cuenca. 

 
 

 Evapotranspiración  
 
La evapotranspiración se puede definir de forma simple como la composición de los 
fenómenos de evaporación desde la superficie del suelo y la transpiración de la 
vegetación.  
 
Thornthwaite et, al. (1944) introduce un nuevo concepto en el cual divide la 
evapotranspiración en 2 formas “potencial y real (ETP-ETR)”, la primera la 
denomina como como la máxima cantidad de agua que puede evaporarse desde un 
suelo completamente cubierto de vegetación, que se desarrolla en óptimas 
condiciones, y en el supuesto caso de no existir limitaciones en la disponibilidad de 
agua. Mientras que la cantidad de agua que realmente vuelve a la atmósfera por 
evaporación y transpiración, se conoce como evapotranspiración real. 
 
Sánchez (1992), menciona que la estimación de la evapotranspiración potencial 
utilizando formulaciones empíricas (Thornthwaite, Hargreaves, etc.) depende de la 
fuente de datos disponible y del ajuste del método a las condiciones locales.  
 

Por lo anterior, para hallar las variables que se emplearían en el cálculo de la 
Evapotranspiración Potencia (ETP), del área de investigación. Se basó en las 
recomendaciones expuestas en el estudio realizado por CORTOLIMA (2015), que 
hacen referencia la opción de variables directas la altura y la temperatura, debido a 
la correlación que tienen estas 2 variables y como se marca un patrón de acuerdo 
a la ubicación de las estaciones. 
 
Para el cálculo de la evapotranspiración potencial, se determinó en función de la 
latitud (representativa de la extensión de horas-sol por día) y la temperatura media. 
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1- Se calcula un “índice de calor mensual” (i) a partir de la temperatura media 
mensual (t): 

 

 
                            
 

2- Se calcula el “índice de calor anual (I ) sumando los 12 valores de i: 
 

 

 
 
 

3- Se calcula la ETP mensual “sin corregir” mediante la fórmula: 
 
 

 
 
Donde: 
 

ETPsin corr = ETP mensual en mm/mes para meses de 30 días y 12 horas 
de sol (teóricas) 
t = temperatura media mensual, ºC 
I = índice de calor anual, obtenido en el punto 2º 
a = 675 . 10-9 I3 - 771. 10-7 I2 + 1792. 10-5 I + 0,49239 
 
 

4- Corrección para el nº de días del mes y el nº de horas de sol: 
    
 

 

 
 
Donde:  
 

ETP = Evapotranspiración potencial corregida 
N = número máximo de horas de sol, dependiendo del mes y de la latitud  
d = número de días del mes 

 
Fuente: Sánchez (2010). 
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Para la estimación de la evapotranspiración Real (ETR), se realizó de acuerdo a lo 
señalado por Mendoza y Sandoval, (2002); los cuales establecen que el  método 
Budyko es uno de los más sencillos y confiables para estimar evapotranspiración 
real, ya que solo se necesitan  2 variables calculadas ETP y precipitación, (Fig. 3). 

 
Figura No. 3: Métodos de los cálculos de Evapotranspiración, Fuente: Mendoza 

y Sandoval, (2002). 
 

García y Otero (2005), hacen referencia al  fundamento teórico de la metodología 
para la estimación de la evapotranspiración real (ETR), mediante la ecuación de 
Budyko la cual se basa en un balance de masas; Budyko notó que cuando la 
precipitación decrece, la escorrentía superficial también decrece, pero cuando la 
precipitación aumenta, el caudal tiende a un valor límite. Por lo cual, desarrollo un 
modelo matemático basado en las ecuaciones de Schreiber (1904): 
 

 

 
y de Ol’dekop (1911), 
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Budyko (1948), interpola las ecuaciones anteriores, proponiendo la media 
geométrica.  
 
 

 
 

Donde ETR es la evaporación real, P es la precipitación (mm) y ETP es la evaporación 

potencial en mm por el período considerado. 
 

“Esta ecuación fue utilizada para hallar los valores medios totales de la 
evapotranspiración real dentro del área objeto del presente estudio”. 
 
Posteriormente estos resultados se unen  a través de Joins and Relates para cada 
estación interpolando los resultados de ETR (evapotranspiración real), por medio 
del método IDW, para conseguir una capa raster que nos represente los datos 
espacialmente. (Software Arcgis 10.2.2) 
 
 
5.2.4 Fase 4. Encontrar la Oferta Hídrica de la Zona de Estudio.   
 

 Balance Hídrico a Largo Plazo y Caudal Medio:  
 
El Balance Hídrico consiste en la aplicación del principio de la conservación de masa 
al conjunto de una cuenca o a una cierta parte de ella definida por unas 
determinadas condiciones de su entorno “entradas y salidas del sistema”4.  
 
Para la estimación de los caudales medios, se empleó la ecuación del método del 
balance hidrológico de largo plazo, con la finalidad de hallar la oferta (disponibilidad) 
del recurso hídrico teniendo en cuenta su distribución espacial y temporal. Para 
calcular dicha estimación se utilizó la siguiente formula: 
 

 
 
 
 
4Universidad Da Coruña, Hidrologia Superficial y Subterranea (D. d. contruccion, Ingenieria de Obras Publicas), 
2015. Obtenido de Internet: http://caminos.udc.es/info/asignaturas/grado_itop/415/ 
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Donde, P(x, y) es la precipitación que recibe el punto (x, y) en el período 
considerado, E(x, y) es la lámina de agua que se pierde por evapotranspiración en 
el punto (x, y) en el mismo período, y dA es un diferencial de área de la cuenca, 
(Grimaldos, 2013). 
 
Para facilitar los cálculos Hidrológicos se utilizó el software  de ArcGIS 10.2.2, el 
cual provee diversas funcionalidades para la obtención de los resultados. 
 
Para aplicación de esta metodología en ArcGis 10.2.2, debemos contar con un 
raster de Precipitación, de Evapotranspiración real y el raster del área de la cuenca 
(MDE) y hacer las operaciones por medio de Raster Calculator, que se encuentra 
en la caja de herramientas Arctoolbox – Spatial Analyst Tools – Map Algebra.  
 
Según CORTOLIMA (2015), se calcula el área del tamaño de los píxeles, se 
desarrolla la ecuación del balance hídrico de largo plazo (1) y el  resultado de esta 
operación, se multiplica por el área del píxel, obteniéndose el volumen de agua 
(caudal), que cada uno de los píxeles aporta durante el periodo de tiempo de datos 
analizados.  
 
Dado que la precipitación y la evaporación real generalmente se miden en mm/año, 
el área en m² y el caudal se desean en L/s o m3/s, debemos utilizar un factor de 
conversión para tener unidades homogéneas. 
 
Posteriormente con el raster generado del volumen de agua (Caudal), realizamos 
una Estadística Zonal (Zonal Statistics) para determinar el caudal medio de la 
cuenca (oferta hídrica) en litros por segundo (L/s). Se generó una tabla con la 
información estadística de la zona de estudio con la información del caudal medio 
en litros por segundo, de la Subzona Hidrográfica del rio Tetuán y rio Ortega;  la ruta 
fue la siguiente  “Arctoolbox> Spatial Analyst >Zonal>Zonal Statistics Table”.  
 
5.2.5 Fase 5. Hallar las áreas de mayor importancia Estratégica para el 
abastecimiento Hídrico de la zona urbana del municipio  de Ortega. 
 

 Delimitación la Cuenca Hidrográfica que abastece la zona urbana del 
municipio. 

 
Para encontrar las áreas de mayor importancia hídrica, debemos de hallar el límite 
de la cuenca que abastece la zona urbana del municipio de Ortega, Tolima; según 
el PBOT (2001), del municipio de Ortega, el Rio anaba es la fuete abastecedora del 
casco urbano desde el año 1992, red hídrica que pertenece a la Subzona 
Hidrográfica del rio Tetuán y rio Ortega, (coordenadas de la desembocadura X: 
868964  Y: 928487). 
 
 
 

http://aguaysig.blogspot.com/2011/06/funciones-zonales-en-arcgis-pendiente.html
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Para delimitar el área de esta cuenca hídrica (Rio Anaba), se procedió mediante las 
herramientas hidrológicas del software Arcgis 10.2.2, (Hydrology). El cual permite 
modelar de forma automática un flujo de agua a través de un modelo de elevación 
digital-DEM (ASTER GDEM 30m).  
 
La metodología aplicada para esta parte del trabajo fue la referenciada por la 
Universidad Nacional Agraria de la Selva. Facultad De Recursos Naturales 
Renovables, Capitulo V. ANÁLISIS HIDROLÓGICO Y MORFOMÉTRICO DE 
CUENCAS “Manual de ArcGis 10, Nivel Intermedio”, (Puerta et al., 2013). 
 
El primer paso fue recortar el DEM (ráster) en ArcGIS 10.2.2, tomando como base 
el polígono  Subzona Hidrográfica del rio Tetuán y rio Ortega. Dentro del ArcToolbox 
encontramos las herramientas Extraction de Spatial Analyst, que permite recortar el 
archivo ráster; la ruta del procedimiento es el siguiente, ArcToolbox > Spatial Analyst 
Tools > Extraction > Extract by Mask, (Fig. 4). 
 
“Cabe resaltar que el DEM viene con un sistema de coordenada WGS84; por lo 
cual, se proyectó al Sistema de coordenadas MAGNA Colombia Bogotá, sistema 
que se eligió para la modelación de los datos; lo anterior se realizó a través del 
siguiente recorrido: caja de herramientas ArcToolbox, Data Management Tools, 
Projections and Transformations > Raster > Project Raster” 
 
Posteriormente se utilizó la herramienta Fill; herramienta que permite rellenar vacíos 
en la superficie del ráster para quitar imperfecciones en la información del DEM, 
(ArcToolbox > Spatial Analyst Tools > Hydrology > Fill). 
 
Luego se aplicó la herramienta Flow Direction, esta herramienta crea un ráster con 
la dirección de flujo de cada una de sus celdas hasta su vecina cuesta abajo, la ruta 
fue la siguiente: ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction. 
“se toma como raster de entrada el generado con la herramienta fill realizado en el 
paso anterior”. 
 
Según Puerta et al., (2013) la dirección del flujo (Flow Direction) es el primer paso 
en el análisis de superficies hidrológicas; ya que todas las restantes herramientas 
hidrológicas requieren de esta información para trabajar; la herramienta Flow 
Direction encuentra la dirección del flujo para una celda comparando su valor de 
elevación con los valores de la elevación de sus celdas vecinas. El resultado es un 
código que identifica al vecino hacia donde el agua fluirá, (Fig. 5). 
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Figura No. 4: Extract del DEM para la zona de estudio, generado en Arcgis 10.2.2. 
 
 
Jenson and Domingue (1988), referencia la Existencia de ocho direcciones de 
salida válidas que se relacionan con las ocho celdas adyacentes hacia donde 
puede ir el flujo. Este enfoque comúnmente se denomina el modelo de flujo de 
ocho direcciones (D8). 
 
 

 
Figura No. 5: Codificación de la Dirección de Flujo, Fuente: Puerta et al., (2013) 
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Seguidamente con la herramienta Flow Accumulation, se crea un ráster del flujo 
acumulado para cada una de sus celdas, esto quiere decir que se calcula para cada 
celda la cantidad de agua que fluye dentro de la celda desde todas las celdas que 
drenan hacia ella, (Fig. 6). Utilizando como entrada el  ráster generado en el paso 
anterior (Flow Direction). “ArcToolbox > Spatial Analyst Tools > Hydrology > Flow 
Accumulation”.  
 
 

                   
Figura No. 6: Modelo de Acumulación de Flujo, Fuente: Puerta et al., (2013) 
 
 
Para Finalizar se crea un se crea un nuevo shapefile tipo punto para obtener la 
cuenca del Río Anaba, y se ubica en el punto de desembocadura al Rio Ortega; 
localizado en las coordenadas X: 868964  Y: 928487, luego se delimita la cuenca 
mediante la herramienta Watershed (ArcToolbox >Spatial AnalystTool >Hydrology 
> Watershed), ingresando como entrada el raster de dirección de flujo (Flow 
Direction), más el shapefile tipo punto (desembocadura). Por último se convierte  de 
ráster a polígono (ArcToolbox >Conversion Tools>From Raster> Raster to Polygon), 
para determinar el área de la cuenca, el perímetro y el caudal medio a través de un 
Zonal Statistics Table posteriormente.  
 

 Identificación de las áreas de mayor importancia estratégica. 
 
Para poder identificar las áreas de importancia estratégica se tienen que establecer 
las corrientes hídricas de primer orden; Esta clasificación se obtuvo por medio del 
Método de Strahler, el cual describe que un mismo río puede tener segmentos de 
distinto orden a lo largo de su curso, en función de los afluentes que llegan en cada 
tramo. El orden no se incrementa cuando a un segmento de un determinado orden 
confluye uno de orden menor, (Strahler, 1952). Esto hace referencia a que se 
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establece un orden de uno (1), a los drenajes o cauces sin tributarios, 
referenciándolos como un drenaje hídrico o cauce de primer orden.  
 
Puerta et al., (2013) implementa esta clasificación a medida que los cauces 
aumentan cuando los cauces del mismo orden se intersecan; por lo cual, la 
intersección de dos vínculos de primer orden creará un vínculo de segundo orden, 
la intersección de dos vínculos de segundo orden creará un vínculo de tercer orden, 
y así sucesivamente. Sin embargo, la intersección de dos vínculos de distintos 
órdenes no aumentará el orden, (Fig. 7). 
 
Para poder identificar las corrientes de primer orden, el primer paso fue clasificar las 
celdas con acumulación de flujo superior a un umbral especificado denominadas 
como celdas pertenecientes a la red de flujo. El umbral debe ser especificado como 
el número de celdas vertientes a la que se está clasificando en cada momento. Aquí 
se debe incorporar el valor que sería el más indicado, ya que si el valor de 
acumulación es muy bajo muchos pixeles serán seleccionados como pertenecientes 
a la red hídrica, si por lo contrario, el valor del pixel es muy alto solo aquellos 
drenajes de orden alto serían definidos como red hídrica. Esto quiere decir, que al 
seleccionar un valor bajo del umbral significa que obtendremos afluentes pequeños 
en nuestra red de drenajes, en cambio un valor alto, modela los drenajes de mayor 
tamaño, (Puerta et al., 2013). Para generar la red de corrientes a partir del ráster de 
acumulación de flujo, creado en la fase anterior (5.2.5.1. Fase 1), y se realizó de la 
siguiente manera: ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster 
Calculator; utilizando la formula Red_drenage= con(“FlowAcc_flow” > 100, 1). 
 
Asimismo, se utilizó la herramienta Stream Link, la cual divide el cauce en 
segmentos no interrumpidos. Es decir, que dichas secciones en las que se divide el 
recorrido del flujo serán segmentos que conectan dos uniones sucesivas, una unión 
y un punto de desagüe o una unión y una división del área de drenaje; la ruta fue la 
siguiente ArcToolbox >Spatial AnalystTool >Hydrology >Stream Link, (como raster 
de entrada se utilizó el generado en el punto anterior y el raster de dirección de 
flujo). 
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Figura No. 7: Clasificación de Redes Método Strahler, Fuente: Puerta et al., (2013) 
 
Posteriormente, se realizó la clasificación el orden de las cuencas de acuerdo con 
el método de Strahler, utilizando la herramienta “Stream Order”, más el raster 
creado anteriormente (Stream Link) y el raster de dirección de flujo (Flow Direction). 
El mapa de procedimiento fue el siguiente: ArcToolbox >Spatial AnalystTool 
>Hydrology >Stream Order. Seguidamente se utilizó la herramienta “Stream to 
Feature”, para Crea un shapefile de drenajes con su respectivo número de nivel de 
orden dentro de la cuenca. 
 
Después, se utilizó la herramienta “Feature Vertice To Point”, con la finalidad de 
obtener un punto al inicio de los drenajes de primer orden dentro de la  cuenca, El 
procedimiento realizado fue el siguiente: se seleccionó los drenajes de primer orden 
y mediante la caja de herramientas ArcToolbox se escogió Data Management tools 
>Feature >Feature Vertice to Point, (tomando como opción que la ubicación del 
punto sea el inicio del drenaje).  
 
Seguidamente, al obtener el punto al inicio del drenaje, en la misma categoría de 
herramientas se selecciona Add XY Coordinates, para obtener las coordenadas X, 
Y para cada punto, con el fin de georreferenciar los puntos dentro de la cuenca.  
 
Al mismo tiempo se generó un buffer para determinar el área de influencia que 
conforma cada drenaje de primer orden en un radio de 100 metros a la redonda. 
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6. RESULTADOS 
 

6.1 DESCRIPCIÓN DE RESULTADOS 
 
Fase 1. Identificación de la Zona hidrográfica  
 
Al indentificar la subzona Hidrografica (rio Tetuán y rio Ortega), a la cual pertenece 
nuestra area de estudio, se puede visulizar espacialmente su area dentro del 
municipio de Ortega, (Fig. 8). 
 

 
Figura No. 8: Subzona Hidrográfica del Río Tetuán y Río Ortega. 
 
 
Subzona Hidrográfica del rio Tetuán y rio Ortega, tiene un área aproximada de 
120564 hectáreas, de las cuales 63000 hectáreas (aprox.) pertenecen al municipio 
de Ortega, lo que equivale al 52% de toda el área de la Subzona (Fig. 8); cabe 
mencionar, que la zona urbana de este municipio se encuentra dentro de los límites 
de dicha Subzona Hidrográfica. 
 
Se resalta, que los polígonos de la cuenca Cucuana y de Saldaña bajo, son 
descartados, debido a que no tienen influencia directa dentro de la zona de interés 
del presente estudio, (Fig. 9). 
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Figura No. 9: Calculo de las areas de los polígonos de la zona de estudio, generado 
en Arcgis 10.2.2. 

 
 
Fase 2.  Determinación de las estaciones con influencia. 
 
Basados en la selección de la 20 estaciones meteorológicas (Fig. 2), determinadas  
mediante el método de los polígonos de Thiessen, se encontró las áreas de 
influencia de estas 20 estaciones dentro de la Subzona Hidrográfica Rio Tetuán y 
Rio Ortega, (Fig. 10). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura No. 10: Área de influencia de cada estación en la zona de estudio a través 
de los Polígonos de Thiessen, generado en Arcgis 10.2.2. 
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Fase 3. Procesamiento de información de las Estaciones Meteorológicas del  
IDEAM. 
 
Precipitación 
 
Al interpolar el total de las medias mensuales multianuales de precipitación (Tabla 
No.1), por medio del método IDW, se obtuvo como resultado una imagen raster de 
tendencia del comportamiento o distribución de la precipitación dentro de Subzona 
hidrográfica del Río Tetuán y Rio Ortega (anexo, C); se visualizó que la Cuenca del 
Río Anaba presenta una precipitación media baja (1896.84mm promedio) de 
acuerdo a los rango establecidos para la zona de estudio de la subzona hidrográfica, 
(Tabla No.2). 
 
Tabla No.1: Total de medias mensuales de precipitación para cada estación. 
 

No. ESTACION 
TOTAL MEDIAS 

MENSUAES 
MULTIANUALES  

1 ATACO  2053,3 

2 LIMON EL  3091,2 

3 GUAINI  2589,9 

4 DEMOSTRACION GJA  2739,6 

5 PANDO EL  2594,0 

6 COLACHE HDA  1560,8 

7 OLAYA HERRERA  2275,9 

8 GUAYABOS LOS  1488,6 

9 JABALCON  1496,5 

10 SAN JOSE D HERMOSA 1715,2 

11 SAN ANTONIO QUINTA  2060,2 

12 PIEDRAS DE COBRE  1505,8 

13 MOLINO MURRA  1583,8 

14 ORTEGA  1821,6 

15 RONCESVALLES  1461,6 

16 LORENA LA HDA  1735,6 

17 STA HELENA  1894,2 

18 RIOMANSO  1958,4 

19 VALLE DE SAN JUAN 1 1548,0 

20 VALLE DE SAN JUAN  1537,3 
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Tabla No. 2: Rangos de distribución de la precipitación dentro del área de estudio. 
 

No. Rango (mm) Clasificación 

1 1,505.78 - 1,752.54 Baja 

2 1,752.54 - 1,999.31 Media Baja 

3 1,999.31 - 2,246.07 Media 

4 2,246.07 - 2,492.84 Media Alta 

5 2,492.84 - 2,739.61 Alta 

 
Temperatura 
 
Se obtuvo como resultado un mapa de contornos de la temperatura para toda la 
Subzona Hidrográfica (anexo, D), que al analizarse en relación a la ubicación de la 
cuenca del Rio Anaba dentro de dicha subzona; y tomándose como base la 
temperatura media mensuales registradas por cada estación (Tabla No. 2); tal cual 
como se explica en el numeral 5.3.4 de la metodología; sé que determinó que la 
Cuenca del Rio Anaba registra una temperatura media-alta de 26 C° basada en los 
rangos de distribución de este parámetro en la zona de estudio. 
 
Tabla No. 3: Temperatura Media de cada estación.  
 

No. ESTACION 
TEMPERATURA MEDIA 

MENSUALES MULTIANUALES 

1 ATACO  27.5 

2 LIMON EL  23.6 

3 GUAINI  24.5 

4 DEMOSTRACION GJA  24.5 

5 PANDO EL  24.9 

6 COLACHE HDA  28.3 

7 OLAYA HERRERA  27.6 

8 GUAYABOS LOS  25.7 

9 JABALCON  27.9 

10 SAN JOSE D HERMOSA 14.7 

11 SAN ANTONIO QUINTA  21.5 

12 PIEDRAS DE COBRE  28.6 

13 MOLINO MURRA  28 

14 ORTEGA  27.5 

15 RONCESVALLES  14.9 

16 LORENA LA HDA  27.8 

17 STA HELENA  13.4 

18 RIOMANSO  17.1 

19 VALLE DE SAN JUAN 1 26.1 

20 VALLE DE SAN JUAN  24.3 
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Tabla No. 4: Rangos de distribución de la Temperatura dentro del área de estudio. 
 

No. Rango (C°) Clasificación 

1 16.3 - 18.7 Baja 

2 18.7 - 21.2 Media Baja 

3 21.2 - 23.6 Media 

4 23.6 - 26.1 Media Alta 

5 26.1 - 28.5 Alta 

 
Evapotranspiración  
 
Mediante el cálculo de la Evapotranspiración Potencial-ETP, la cual se obtuvo 
mediante las ecuaciones descritas en el punto 5.2.3, más los datos de precipitación 
media, se halló la media total de la Evapotranspiración Real-ETR (Tabla No.5), lo 
que permito evidenciar que la Cuenca del Rio Anaba presenta una 
Evapotranspiración Alta (905.98mm promedio), dentro de la Subzona Hidrográfica 
(anexo, E), de acuerdo a los rangos de distribución establecidos para esta área 
(Tabla No. 6). 
 
Tabla No. 5: Total de medias mensuales de la Evapotranspiración Real (ETR) para 

cada estación.  
 

No. ESTACION ETR_MED_TOT 

1 ATACO  1065.9 

2 LIMON EL  981.7 

3 GUAINI  978.5 

4 DEMOSTRACION GJA  959.8 

5 PANDO EL  964.5 

6 COLACHE HDA  957.3 

7 OLAYA HERRERA  1046.1 

8 GUAYABOS LOS  782.1 

9 JABALCON  955.1 

10 SAN JOSE D HERMOSA 552.0 

11 SAN ANTONIO QUINTA  791.9 

12 PIEDRAS DE COBRE  968.8 

13 MOLINO MURRA  990.5 

14 ORTEGA  986.3 

15 RONCESVALLES  523.9 

16 LORENA LA HDA  946.1 

17 STA HELENA  485.7 

18 RIOMANSO  638.5 

19 VALLE DE SAN JUAN 1 897.7 

20 VALLE DE SAN JUAN  753.7 
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Tabla No. 6: Rangos de distribución de la Evapotranspiración Real dentro del área 
de estudio. 
 

No. Rango (mm) Clasificación 

1 569.80 - 752.85 Baja 

2 752.85 - 891.08 Media  

3 891.08 - 1,046.12 Alta 

 
 
Fase 4. Oferta Hídrica de la Zona de Estudio.   
 
Balance Hidrico y Caudal Medio 
 
De acuerdo a lo realizado en la metodologia numeral 5.2.4 “Balance Hídrico a Largo 
Plazo y Caudales Medios”, se obtuvó la oferta hidrica de la zona, (anexo, F); lo cual 
permitió evidenciar que el caudal medio de Subzona Hidrográfica  Rio Tetuan y Río 
Ortega es de 44705 L/sg aproximadamente, (Fig. 11). 
 

 
Figura No. 11: Zonal Statistics Table de la Subzona Hidrográfica  Rio Tetuan y Río 

Ortega, generado en Arcgis 10.2.2. 
 

 
Fase 5. Áreas de mayor importancia Estratégica. 
 
Delimitación la Cuenca Hidrográfica que abastece la zona urbana del municipio. 
 
La delimitación de cuenca hidrográfica de la cual se abastece la zona urbana del 
municipio de Ortega, determinada mediante el procedimiento descrito en el numeral 
5.2.5; posibilitó hallar el límite de la Cuenca del Rio Anaba (anexo, G), la cual está 
conformado por 4.000 hectáreas aproximadamente. Asimismo, el análisis realizado 
a través del Zonal Statistics Table, para la cuenca del Rio Anaba arrojo como 
resultado un caudal medio (oferta hídrica), de 1340 L/sg aproximadamente, (Fig. 
12). 
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Figura No. 12: Zonal Statistics Table para la Cuenca del Rio Anaba, generado en 

Arcgis 10.2.2. 
 

Identificación de áreas de mayor importancia estratégica 
 
Mediante el Método de Strahler, se logró clasificar el orden de las corrientes 
hídricas de la cuenca, utilizando herramientas geoinformáticas, obteniendo como 
resultado la identificación de 98 corrientes de primer orden; corrientes con un grado 
de mayor de importancia para la conformación del cauce principal. Estas corrientes 
de primer orden se georreferenciacion espacialmente al inicio de cada una de ellas 
(anexo, B), de esta forma se generó un mapa que ilustra las áreas de mayor 
importancia estratégica de la cuenca del Río Anaba y los ecosistema que incidan 
en un área de influencia de 100 metros a la redonda, (anexo, H). 
 
6.2 DISCUSIÓN DE RESULTADOS 
 
Al observar los resultados obtenidos, se puede evidenciar que la cuenca del Rio 
Anaba se ubica dentro de la Subzona Hidrográfica del Rio Tetuán y Rio Ortega, en 
una zona de precipitación media baja (anexo, C); asimismo, al compararse con las 
temperaturas generadas, se localiza en la región de mayor temperatura dentro de 
la subzona hidrográfica, con una temperatura media de 25°C (anexo, D); de la 
misma forma se encuentra dentro de la región alta en cuanto Evapotranspiración 
Real (ETR).  
 
Aunque el caudal medio de la Cuenca del Río Anaba arrojo 1340 L/sg, frente a una 
demanda de 68.5 L/sg “según el libro maestro de concesiones de aguas de la 
Corporación Autónoma Regional del Tolima” (anexo, A), de los cueles 28 L/sg son 
para abastecimiento de la Zona Urbana del Municipio de Ortega. Se puede percibir 
que no se presenta conflictos con respecto al acceso al agua; sin embargo, al 
contrastarse con la Oferta Hídrica de la Subzona Hidrográfica (anexo, F), la Cuenca 
del Río Anaba presenta una oferta hídrica media baja en la zona.  
 
Por lo anterior, y tomando en cuenta los análisis de resultados de Precipitación, 
Temperatura y ETR,  se puede inferir que es una cuenca susceptibles a los cambios 
generados por el Cambio Climático, lo cual, podría genera una preocupación por la 
reducción de su caudal medio (oferta Hídrica) en los próximos años si continua el 
proceso de calentamiento del planeta; además, el incremento acelerado de la 



 

 

42 

 

 

frontera agrícola y de su población en el sitio, acrecentad un panorama desalentador 
para la cuenca abastecedora del municipio.  
 
Conseguir clasificar el orden de las corrientes hídricas que integran la cuenca del 
Rio Anaba a través del Método de Strahler, aplicando herramientas 
Geoinformaticas, nos genera un factor importante como unidad de Gestión de la 
cuenca; identificar las corrientes de orden uno y su área de influencia (anexo, H), 
suponen un avance importante en la conservación de estos ecosistemas 
estratégicos y de todos los componente biótico que interactúa y conforman este 
medio.  
 
Asimismo lograr referenciar su localización (Coordenadas XY), de estas corrientes 
hídricas de primer orden mediante un punto de inicio de dichos drenajes, generan 
una ventaja al momento de realizar reconocimiento de estos sitios por parte de las 
entidades territoriales, facilitando la labor de identificación de los ecosistemas 
estratégicos que interactúan dentro del área de influencia de estas corrientes 
hídricas. 
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7. CONCLUSIONES 
 

 Se puede concluir que el presente estudio sirve como herramienta base 
para determinar las áreas de importancia estratégica para el 
abastecimiento hídrico de la zona urbana del municipio de Ortega, 
articulándose a los Lineamientos estratégicos del Plan Nacional de 
Desarrollo 2014–20181, “Las Entidades territoriales deberán diseñaran e 
implementaran instrumentos para la identificación y valoración de los 
servicios ecosistémicos y sus vínculos con el bienestar humano para 
fortalecer el uso sostenible de la biodiversidad, la competitividad y el 
crecimiento económico y social”; ya que estos ecosistemas son fábricas 
o proveedores de bienes y servicios, importantes para el desarrollo 
sostenible y satisfacción de nuestras necesidades básicas como 
sociedad.  
 

 Esta clase estudio permite generar información que ayudan en la gestión 
y planificación de las políticas de inversión (1% del presupuesto), para la 
adquisición y mantenimiento de ecosistemas estratégicos y/o crear un 
esquemas de financiamiento de pago por servicios ambientales. Lo que 
contribuye al cumplimiento de lo ordenado en el Artículo 210 Ley 1450 de 
2011, que modifica el Artículo111 de la Ley 99 de 19932, “Declárense de 
interés público las áreas de importancia estratégica para la conservación 
de recursos hídricos que surten de agua los acueductos municipales, 
distritales y regionales”.  

 
 Se puede inferir que La Herramientas Geoinformaticas, son útiles para 

procesar la información de las estaciones meteorológicas y así determinar 
los comportamientos Hidroclimaticos de la Cuenca del Rio Anaba, y a su 
vez de la Subzona Hidrográfica del Rio Tetuán y Ortega a la cual 
pertenece, sirviendo como directriz para su Ordenación y planificación, 
contribuyendo en la gestión integral de la administración del recurso 
hídrico. 
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8. RECOMENDACIONES 
 
 
Es de gran importancia seguir generando metodologías que faciliten el estudio de 
los recursos naturales empleando herramientas Geoinformaticas, las cuales aportan 
resultados con un alto nivel de confiabilidad lo que permite tomar decisiones más 
asertivas dentro de la ordenación socio-ambiental del territorio. 
 
Se recomienda generar estudios que abarque tanto el componente biótico (fauna y 
flora) como el componente socio-económico, que permitan conocer el astado actual 
de la cuenca del Rio Anaba, con el fin de complementar este estudio base y así 
tener un mayor número de herramientas que amplíen la visión del panorama de 
preservación y conservación de esta unidad hidrográfica dentro de los criterios de 
planificación y ordenación. 
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